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BrightLink® for Education_

Welcome to the BrightLink community!

We’re excited to see investments made in your classroom and the addition of new tools to
support your teaching.

Now it’s the tough part. If you thought getting the new projector in your classroom was
difficult, now you have to figure out how to use it. Yikes!

Collaborate. Inspire. Explore. But how?

We know teacher’s have a lot to handle so we want to make sure getting up and running
with BrightLink is as painless and quick as possible.

That’s where your Welcome Tool Kit comes in handy. Take a few minutes and =]
walk through the different steps to setup and familiarize yourself with the =g
projector, pen and software. Then pop the DVD into your computer for quick

access to even more resources.

Have an hour to kill? Check out our ongoing webinars schedule or watch an archived
webinar from last month.

How about just 5 minutes? Check out our video bank; and, learn something e,
today in about 5 minutes you can put to good use tomorrow. .

Visit epson.com/brightlink. It’s your Resource Center for Epson =
Interactive i

What you’ll find:
Webinar descriptions and schedules
Video tutorials
Links to free resources
Ways to help you learn your new tools

Help us help BrightLink teachers out there. Spread the news that by signing up at
Epson.com/eduresources we’ll make sure you’re the first to know about the helpful tools
we’ve been finding and building for you - our interactive users.

Thank you!

The Epson BrightLink Interactive Team

EPSON AMERICA, INC. 3840 Kilroy Airport Way
Long Beach, California 90806-2452

TEL562.981.3840
P.0. Box 93012
Long Beach, CA 90809-9941

www.epson.com



BrightLink

EXCEED YOUR VISION

Start Here

Follow the steps on this card to get started with your
BrightLink:

@ Connect your computer and turn on the projector

@ Make sure the software is installed

@ Calibrate

* Using the remote control

@ Use the interactive pens
¢ Choosing the right tool

@ Use PC Free Annotation

BrightLink Interaction

The projector control toolbar lets you control the
projector from the screen just as you would using the
remote control.

The BrightLink interactive pens turn any wall or table into
an interactive area, with or without a computer.

® With a computer, you can use Easy Interactive Tools.
This software lets you use the interactive pen as a
mouse to annotate, save, and interact with content
from your computer.
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® Without a computer, you can use the toolbar that is
built into the projector (PC Free Annotation). This
lets you annotate images from a document camera,
tablet, DVD player, or other source connected to your
projector.

Students and colleagues can connect their own
laptops and annotate on the fly using the built-in
toolbar, without installing software.
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Turn on the Projector

(1) Connect Your Computer and

Connect the USB cable from the projector’'s USB
TypeB port directly to any available USB port on
your computer.

=)
USB cable

Connect an HDMI or VGA cable from the projector to
your computer.
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Turn on the projector by pressing the blue () power
button on the remote control.

In Windows®, you may see messages about device
drivers or new hardware.

The default language of the menu system is English.
To select another language, press the Menu button
on the remote control. Select Extended and press
"'/é. Select Language and press "’/é. Select your
language and press"’/é. Press the Menu button to
exit the menu system.

Display an image from your computer. If the image
doesn’t appear, try one of the following:

¢ On some Windows laptops, you may need to
hold down the Fn key on the keyboard and press
F7 or the function key that lets you display on
an external monitor. It may have an icon such as
&/0, or it may be labelled CRT/LCD.

® (On a Mac, you may need to open System
Preferences and select Displays. Select the
display or Color LCD option if necessary, then
click the Arrange or Arrangement tab, and
select the Mirror Displays check box.

® Try pressing the Source Search button on the
remote control.



@ Make Sure Interactive Software Is Installed

You may already have interactive software on your
computer, or you may need to install it. For

OS X, you need Easy Interactive Driver and Easy
Interactive Tools (or other interactive software). For
Windows, you only need Easy Interactive Tools (or other
interactive software).

Here’s how to find out if the Easy Interactive Tools
software is installed on your computer:

If you are using a Mac:

Look for the Easy Interactive Driver and Easy Interactive

Tools folders in the Application folder on your hard drive.
If you see these folders, the Easy Interactive software is

installed.

If you are using Windows:
Windows 8.x
Navigate to the Apps screen and select Easy Interactive

Tools.

All other versions

Select @ or Start > All Programs or Programs >
EPSON Projector > Easy Interactive Tools Ver. 3.

If you see Easy Interactive Tools Ver. 3, the software is
installed.

If the software is not installed, follow the steps in the next
column to install it.

If you need to install the Easy Interactive Tools
software

Do one of the following:

® Use the CD that came with the projector, labeled
“EPSON Projector Software for Easy Interactive
Function”
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® Download the most up-to-date version from:
epson.com/brightlinkdownloads (U.S.)
epson.ca/brightlinkdownloads (Canada)
global.latin.epson.com/soporte (Latin America;
site available in Spanish)

For more information about Easy Interactive Tools, see
the online Easy Interactive Tool Tips sheet or the online
BrightLink User's Guide.



@ Calibrate

Calibration coordinates the position of the pen with the
location of your cursor. If the pen position and cursor
location don’t match, you can try auto calibration, or you
can calibrate manually for even greater accuracy. You
don’t need a computer, and you won't need to calibrate
again unless the projector or image is moved, or the
image is resized.

To start calibration, press the User button on the
remote control.

2 When you see the Auto Calibration screen, do one
of the following:

® Press "’/5 to try auto calibration, then wait until
calibration is complete.

® Select No, then press "’/é and follow the steps
below to calibrate manually.

3 Press the Menu button on the remote control, select
the Extended menu, and press "'/5.

4 Select the Easy Interactive Function setting and
press "'/é.

N/

5 Select Manual Calibration, then press &

6 When you see this screen, press ‘J/é to select Yes.

[Manual Calibration]

Touch each mark shown on the screen with the

pen.
Continue untif you have touched all marks up
to the final mark shown on the lower right.
Calibration starts when preparations are
compiete. Do you want to continue?

[ Yes @ Ho

Touch the circles on the screen to perform manual
calibration.

For more detailed instructions, see the online BrightLink
User’s Guide.

Using the Remote
Control

Turn projector Select from various

on/off —— —— Image sources
Video  USB connected to the
- s ? projector
Access menu
system for Switch between
additional computer and Easy
adjustments Interactive Pen
Enter
Calibrate
2l Zoom in and out
Page through
documents
Temporarily
turn off image ——&_ ) (. Stop video action
and sound

For more information on using the remote control and
cool time-saving buttons:

¢ See the online BrightLink User’s Guide.

® Go to the training section and watch a video or two at
epson.com/brightlinkvideos (U.S.) or
epson.ca/brightlinkvideos (Canada).



@ Use the Interactive Pens

Your projector came with 2 pens that have different
colored ends, orange (Interactive Pen A) and blue
(Interactive Pen B). Make sure one AA battery is installed
in each pen.

Battery cover
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Pen tip Battery Button
light

® To turn on the pen, tap the pen tip or press the button
on the side of the pen. The green light comes on
briefly. If the battery is low, the light flashes.

® Hold the pen perpendicular to the board, as shown
below.

® To left-click, tap on the board.

® To double-click, tap twice.

® To right-click, press the button on the side of the pen.
® To click and drag, tap and drag with the pen.

® To move the cursor, hover over the board without
touching it.

® When you are finished using the pen, simply place it in
an area away from the projection screen.

Note: The pens turn off automatically after about 20
minutes of inactivity. Tap the pen tip or press the button
on the side to turn the pen back on.
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Ready to Learn More?

® Sign up for complimentary webinars

® Watch helpful how-to videos

® Find out about cool, free interactive sites

BL

Click the BrightLink Training Resources
link on your desktop or go to
www.epson.com/eduresources.
(U.S. and Canada only)




@ Use PC Free Annotation

The projector’s built-in toolbar iets you annotate images
from other devices that have been connected to the
projector, such as a document camera, tablet, or other
source.

Press one of the source buttons on the remote
control to select the source for the image you want
to annotate.

Source Search

Image from a ; video ﬁ Image from an
computer connected external device
to the Computer1 connected to the
or Computer2 port USB port

Image from a computer or
iPad connected through a
wired or wireless network

Image from a computer with
an HDMI connection, or a
video player

2 To activate the toolbar, tap the board with the pen.
If you don't see the icon, tap the || icon and
then tap the a icon.

Note: If you only see the icon, you are already in
PC Free Annotation mode.

3 To close the toolbar, select the E icon at the

bottom of the toolbar.

Note: Many of the built-in tools are the same as Easy
Interactive Tools, but fewer functions are available.

EPSON is a registered trademark and EPSON Exceed Your Vision is a registered
logomark of Seiko Epson Corporation. BrightLink and PrivateLine are registered
trademarks of Epson America, Inc.

Mac, OS X, and iPad are trademarks of Apple Inc., registered in the U.S. and
other countries.

General Notice: Other product names used herein are for identification purposes
only and may be trademarks of their respective owners. Epson disclaims any and
all rights in those marks.

This information is subject to change without notice.
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Two different toolbars are available in PC Free Annotation
mode, one for annotation mode and one for whiteboard
annotation mode.

® Annotation mode displays the built-in toolbar on
whatever image is being projected.

® \Whiteboard annotation mode lets you project a white
or black screen or background pattern, and use the
pen to write or draw as you would on a chalkboard or
dry erase board.

Select whiteboard
annotation mode

Select annotation mode

Undo ey Redo
Select the background Ii_eJ
pattern* i
Change custom pen ——
color and width | Use custom pen

Change highlighter color = | O Use highlighter
Use black, red, or biue L@ Use black, red, or blue
pen—select smr—:1|| QOt A / ) pen—select large dot
for thin line for thick line
Erase—select small dot ° / o Erase—select large dot
for thin eraser o @ O for thick eraser
@ - Clear all annotations

Hide toolbar after each

annotation i s -

Close toolbar

* In annotation mode, the {<& select background tool does not appear.

Need help?
The Epson® PrivateLine® service is for you!

All you have to do is call (800) 637-7661. This service is
available for the duration of your warranty period.

You may also speak with a projector support specialist by
dialing (562) 276-4394 (U.S) or (905) 709-3839 (Canada).

Support hours are 6 AM to 8 M, Pacific Time, Monday
through Friday and 7 AM to 4 pwm, Pacific Time, Saturday.
Days and hours of support are subject to change without
notice. Toll or long distance charges may apply.




Easy Interactive Tool Tips

«L‘_ To start Easy Interactive Tools on your computer, do one of the following:
® Windows ®; Select @ or Start > All Programs or Programs > EPSON Projector > Easy Interactive Tools.

Or, double-click the @2’1, Easy Interactive Tools icon on your desktop.

® Mac OS X ®: Select Applications > Easy Interactive Tools > Easy Interactive Tools.

The Easy Interactive toolbar appears on the projected image, and an Eﬁ_ l arrow appears on the other side of the
image. Two different toolbars are available, one for interactive mode and one for Whiteboard mode:

e a-TeydiT, \Minda g & :
interactive Mode Whiteboard Mode

In whiteboard mode, the toolbar
appears on a blank surface,
background image, or pattern.

gg}?b“'d You can write or draw with the

In interactive mode, the toolbar
appears on the projected
image and lets you use the
pen as a mouse to open Interactive |

applications, access links, 1ehis pen, add images, and save or

and operate scroll bars, for prin; your pages.,

example.

In this mode, you can also :

annotate whatever is displayed

from your computer or Annotating

document camera and save or o Arrotstion . .

print your pages. tools - = ool You can use the annotation tools
at the bottom of the toolbar in

either mode.

Interactive toolbar Whiteboard toolbar

f/ To toggle between modes, select the @Annotation mode icon to display the interactive toolbar, or the @
~  Whiteboard mode icon to display the whiteboard toolbar,

To exit Easy Interactive Tools, select the E' Exit icon in the lower right corner of the toolbar. You can also minimize the
toolbar by selecting the El Close icon, then select the Eﬂ arrow to redisplay the toolbar.
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Tools for Interactive NMode

Switch to interactive mode —— [EY - Switch to whiteboard mode

—— Save the current screen

Bls

Toggle between pen and mouse modes 1[ a

AR

S
Bleln

Undo/redo muitiple operations (one at a time) .}/ d

Page up/down in a browser or other program

. Use an on-screen keyboard to enter text in a browser or

Display the image from a document camera J ﬁ
F other program

connected to the computer via USB — |

Use the magnifier to enlarge the image —— @

1 Insert a circle, square, triangle, or other shape

B8

Display additional tools for saving, printing, and more ~—— | ﬁ




Tools for Annotation

Change custom pen color and width

- 1 — Write or draw with custom pen

Change highlighter pen color and width ——

[ I
e R

Write or draw with transparent highlighter pen

Use black, red, or blue pen—select small dot for thin lines ——J!

Erase—select small dot for thin eraser —3-0 Q

Clear all annotations ——

Toggle between hiding the toolbar afier use and ——!
showing it continuously

Tools for Whiteboard Mode

- Use black, red, or blue pen—select large dot for thick lines

WVEITODI s M
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Switch to interactive mode ——— rgar‘q —— Switch to whiteboard mode
Select from background ratterns or colors, or display an - - @?' E ~-—— Save the current screen
mage from a document camera ) ll ]
lt ) I & | Undo/redo multiple operations {one at a time)
Display a list of pages currently being edited ) g | =% Open a new page
Insert an image from a file or from a document camera ___ {lo— ey
connected to the computer ol = Delete the current page
Use the magnifier to enlarge the image - @ ' RiI— !)isprlte:a‘):j s; cursor that lets you resize or move an
B nsel mage
Display additional tools for saving, printing, and more : | 5] @ ~— Insert a circle, square, triangle, or other shape
Tools for Saving, Printing, and More

To display the tools shown below, select the @ Other tools icon on the toolbar.

Display a movable spotlight effect. ——

Print the currently displayed image. In whiteboard mode, you can
select the pages to print.

Cover the image with a movable shade

Open the settings screen, which lets you select settings for
saving your pages and more

I

Change the next pen tap to a right click Gnteracrt:"\ged ?g:;? ? —— Display help (interactive mouse mode only)
T To save your screen or pages as .jpg files in your Documents > Easy =~ [==€ 000 :
Interactive Tools folder, simply select the @ Save tool. Easy Interactive e "“‘" |
Tools names your file automatically based on the date and time. S e s
Save location folder |G\ Users* Hary' Documenta\Exey Hiaciva Tooks [
“)  To select other locations and formats for saving, select the @ Settings Rl nans pre
£ - .
tool, then select the Save settings tab, as shown on the right. Are. St ~Caced
€ Bimap (berp)
€ PDF Ris {pdf)
‘2 Select the location, file name, and file type for saving pages. You can save e e
~all your pages as one PDF file. J| | seelcsmiss  Ee T Goomat By iaaava ol | |
Fio reme Fp-r,
f‘, If you want to select different settings each time you save, select the Check . C #mCorbm T P Co)
when saving checkbox. € Biogp Chrp)
T POFFle Cpd)
5 Select OK to close the Settings window. dors demde | = |
CPD-36473
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TeamBoard Draw Tips

To start TeamBoard, do one of the following:

¢ Windows ®: Select @ or Start > All Programs or Programs > Teamboard > Draw.

Or, right-click the M TeamBoard Draw icon in your system tray (lower right corner of your
screen) and select TeamBoard Draw.

® Mac OS X ®: Open the Applications folder and select M Draw.

Add clip art Spotlight
Record  View tutorials Hide/reveal Page sorter
o Toamiosed Dow - Untted =
[Eile Edit_Insest View Toole Help SRR 3
Standard toolbar o = pE e ' EY
Fijpsestosmieceon] |
Main toolbar - i S aa |2 -~ D
| B g T ,
Pen [Shapes| Text |Clipboard I
Eraser Creative Move Submenu
pen
L l ]
Main tools
I
i
Action toolbar —|EaMIGd EL 7 (W A W4 i & Kz |1 <
(Se]ect View > T e e et — = : = -
Toolbars > I
Action Bar) Small eraser Colored pens Copy page Navigation tools
Large eraser Insertpage Print page

The Main toolbar has 7 key tools. Each tool has its own submenu on the right side (after the E red arrow).

@ ) Move your mouse or interactive pen over any of the tool icons to see a definition.

Pen tools Shape tools

# == A —
(Nememmamzrrrrrraa JFTR G BoatAcnceommARR]

Creative pen tools

YDA P ET T 27

Eraser tools Clipboard tools Cut Move tools

Pz omz @ Rs e

Multi-copy Move object] Color fill

Text tools Speak sentence

| Link object
Ti RG> @ % PBemssen -o - BT U =
- I

Select word | Speak word
Word bank

TeamBoard training videos and webinars are available at www.epson.com/brightlink (U.S.) or
www.epson.ca/brightlink (Canada). Select BrightLink for Education, then Training.



Using the Annotation
Toolbar

Select Freshand
or Rectangle to
capture screen

Collapse toolbar Use virtual keyboard

|
MET o se. [
Full-slcreen Open full Open

annotate TeamBoard application
Draw screen list

i
e

To access the floating annotation toolbar or
dashboard, do one of the following:

® Windows: Select @ or Start > All
Programs or Programs > Teamboard >
Annotation.

Or, right-click the f_»_“j TeamBoard Draw
icon in your system tray (lower-right corner
of your screen) and select Annotation.

® Mac OS X: Select the L“Lj?
TeamboardAnnotate icon on your screen.

To take a full-screen snapshot for annotation,
select the §© camera icon. The following
toolbar appears:

Tesmcand Drne i

UeEHATR OB/ AL - e @ ¢ AR g

You can use all of the TeamBoard tools to draw
or annotate on a web page or anything else on
your computer.

To save your annotations and return to your
desktop, select the §@ icon on the right end of
the toolbar.

To save annotated images in TeamBoard, open
the File menu and select one of the following:

® Save as (to save in .tmb file format)

¢ Export (o save in .jpg, .ppt, .bmp, .pdf,
-html, tif, .png, or .iwb file formats)

After you export a .ppt file, you can open it
in PowerPoint®. First you need to associate
PowerPoint with TeamBoard by following the
steps in the next column.

© 2012 Epson America, Inc. 2112
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Presenting and
Annotating in PowerPoint

First, you need to associate PowerPoint with TeamBoard.

Open the Tools menu and select Options.

Select the Application Control tab, then select
the Add button.

Locate and select POWERPNT.EXE in your
Program Files\Microsoft Office folder.

Select OK, then select OK again to close the

Options window.
Tesmsodd Draw - Optiors. T o
| Beven Jfaumee | mg:sa_.lmﬂgl_gqi
[k sid ] rutcrempemesd | (reond
ST R ot I
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Once you have associated PowerPoint, you can open it
from the TeamBoard annotation toolbar:

MEGs0 ve A

| Powerpoint2007

D Easiteach

E_j | PowerpontX103

Additional tools appear on the toolbar as shown below:

Start/stop Black Arrow
presentation screen  too!

AL 2> @B |

| In~show slide

Pens Erasers management

ETee 1e f = 3 iz

You can open your PowerPoint file and annotate it using
the TeamBoard tools. When you are finished, select Keep
to save your “ink annotations” with the PowerPoint file.
This is great for sharing meeting notes.
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